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1. INTRODUCTION

1.1. Overview

Elekta Neuromag Data Acquisition Software is used to control the
measurement device and to acquire data. This manual covers per-
forming measurements with a system that has been installed, con-
figured and tuned. Software installation and basic configuration
are explained in “Elekta Neuromag Data Acquisition Software
Release 4.0 Installation Guide”. Tuning is described in “Sensor
Tuner User’s Guide”.

For a description of the measurement device, main safety instruc-
tions, and a general description how measurements are per-
formed, see “Elekta Neuromag System Hardware User’s
Manual”.

This manual applies only to Elekta Neuromag Data Acquisition
Software Release 4.0. The software allows both evoked response
measurements and recording of continuous raw data. It also sup-
ports MaxShield™ noise reduction system and provides rudimen-
tary continuous head position tracking capabilities.

For a brief description of the software structure, see Appendix A.
For changes from previous release, see Appendix B.

1.2. Typographical conventions

The following typographical conventions are used in this manual.
commands

Typed commands and text as well as messages on non-graph-
ical screens or windows are shown in typewriter font. For
example, commands given to the UNIX shell are written in
this font:

show fiff -v online.fif

These commands should be typed exactly as shown, includ-
ing spaces, underscores, hyphens, slashes, punctuation etc.
only omitting the constructions denoting parameters (see
below). When using the graphical user interface, it is neces-
sary to open a terminal window first in order to type the com-
mands.

buttons and messages

The textual items of the graphical user interface are denoted
with bold Helvetica. The names of buttons, menus and menu
items and messages appearing on graphical windows are
shown in this font. For example:

Select Save averages... from File menu.

NM23065A

Introduction 1



Elekta Neuromag DATA ACQUISITION

means using the mouse or arrow keys to point and activate the
menu labeled as “File”, and then moving the pointer to an
item in this menu reading “Save averages...” and selecting it.

names and parameters

Text in italics indicates the name of an application program,
manual, or other Neuromag item. Italics is also used to intro-
duce new concepts and to emphasize words.

Parameters are marked with italicized text enclosed in angle
brackets (<,>). The whole construction, including the angle
brackets, should be replaced by the value of the parameter.
For example, in the shell command described as

show_ fiff [-v] <data file>

the string <data file> is substituted with a real file name.
Optional parameters or arguments are enclosed in square
brackets.

1.3. Software safety

A\
/A

This product has been designed for the following intended use:

The Elekta Neuromag systems are magnetoencephalographic
(MEG) devices which non-invasively detect and display biomag-
netic signals produced by electrically active nerve tissue in the
brain. When interpreted by a trained clinician, the data provide
useful information about the location of the nerve tissue responsi-
ble for critical brain functions and thus enhances diagnostic capa-
bilities.

Warning: MEG data can be inherently explained by many dif-
ferent source distributions, and measurements often contain vari-
ous kinds of artefacts. Data used for clinical purposes must be
interpreted by a trained clinician who is capable of judging the
relevance and quality of the data.

Warning: Do not use the system without also carefully reading
“Elekta Neuromag System Hardware User’s Manual”.

NM23065A
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2. GETTING STARTED

2.1. Hardware checklist

Before starting a measurement:
1. Check that you have a set of at least three HPI coils available.

2. Check that the evoked-response stimulation hardware is
properly set up, if needed.

3. Check that the necessary electrodes, paste, and other related
items are available for recording electric signals.

2.2. Starting the software

Acgulsition

All the Neuromag analysis and data acquisition application pro-
grams are started by double clicking the corresponding icon in the
Neuromag toolbox. If this toolbox is not on your desktop, open
it by first clicking the tools subpanel on the right side of CDE
front panel (see HP Common Desktop Environment: User’s
Guide for details) and then double-clicking the Neuromag icon.

Once the Neuromag toolbox is open the data acquisition control
program (megacq) 1s started by double clicking the Acquisition
icon. In addition to the main window (see page 4), the raw data
display appears (see Section 5.3. on page 41).

On start-up, megacq checks the integrity of the data path from the
data acquisition system to the UNIX workstation. If no connec-
tion exists, an error dialog indicating the failure pops up. Should
this happen, check first that the data acquisition computer is
switched on (see Technical manual: System hardware). A possi-
ble software problem causing the error can be resolved by the pro-
cedure described in Section 8. on page 57.

Here we assume that the system is tuned and that SSP vectors
used in suppression of external artefacts have been set. For details
see Sensor Tuner User’s Guide and Section 3.10. “On-line signal
space projection” on page 33.

Before proceeding it is advisable to check the available disk space
on data volumes from Disk space... in the Tools menu.

NM23065A
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2.3. Components of the control program

The main window of megacq consists of:

torview system
0 Good work, megacg
D Connections open

1. The menubar with File, On-line, Tools, and Help menus.
2. A log window for informational messages.

3. The setup buttons with a synopsis of the setup state indicated
next to each button.

4. Acquisition control buttons, which are enabled and disabled
according to the state of the acquisition process.

5. A stopwatch for measuring time.

6. Five status message lines indicating the state of the acquisi-
tion.

NM23065A Getting Started 4
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2.3.1. The menus

The items in the File menu store and recall measurement param-
eters from files, thus facilitating setting up for a measurement. See
Section 3.8. “Saving and restoring settings” on page 30 and Sec-
tion 4. “Experiment preparation” on page 35 for the details of the
items in this menu. Finally, there is Quit for exiting the acquisi-
tion system.

The On-line menu contains functions which control the on-line
averager and the on-line average display during a measurement.
See Section 5.4. “On-line averaging” on page 46 for a description
of this menu.

Most of the functions in the Tools menu control the magnetome-
ter probe:

Reset channels

Reset the MEG and EEG channels. To ensure fast settling of
the signals after resetting the electronics the digital high-pass
filter is automatically switched to a high corner frequency for
a couple of seconds and then back to the setup value.

A reset is applied automatically when a measurements starts,
so this function is intended for recovering channels after an
excessive disturbance during a measurement.

Tuner...

Invoke the automatic sensor tuner. For details see Sensor
Tuner User’s Guide.

Squiddler...

Invoke the manual sensor tuner, which allows modifying,
loading and saving tuning parameters, and de-trapping (heat-
ing) the sensors. Refer to Technical Manual: System Hard-
ware for instructions how to tune the sensors. Squiddler can
also be started independently of megacq by using the corre-
sponding icon in the Maintenance folder in the Neuromag
toolbox.

Squiddler_EEG...

Invoke the EEG hardware (Vectorview) or EEG filter (Neu-
romag-122) control program. The applicability of this
depends on the configuration of the particular system.

Helium level...

Show the liquid Helium level history and estimated zero-
level time. This can be done also by clicking the Helium-
Level icon in the Neuromag toolbox or by issuing the com-
mand helium at a command line (provided that the search
path of the UNIX shell includes the directory /neuro/
bin).

Disk space...
Show the available disk space on all mounted volumes.

NM23065A
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2.4. Closing the software

When the measurements are completed and all the necessary data
saved, the acquisition system user interface can be closed to
release computer resources for other tasks. To close the acquisi-
tion programs select Quit in the File menu of megacq. You will
be asked for a confirmation.

All the child applications of megacq (Raw data display, Average
response display etc.) will close automatically.

The state of megacq is not automatically saved when closing it.
Thus, you have to explicitly use the procedures explained in Sec-
tion 3.8. “Saving and restoring settings” on page 30 if you want to
continue using the same parameters.

Note that exiting megacq only closes the user interface of the data
acquisition system, while the real-time system remains powered
on and running. The real-time system is shut down only during
service operations. It is preferable to keep the electronics on
between measurement sessions; the system requires considerable
time to completely stabilize after a power-up.

NM23065A
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3. SETTING UP

This section describes the setup tasks to be performed before
starting the acquisition. If the personal data of the subject are
available, the setup can be completed before the subject arrives.
See “Experiment preparation” on page 35 for more information.

3.1. Project

The measured data are grouped into projects according to the con-
ventions at each site. For example, one project might correspond
to a group of patients with common symptoms or patients inves-
tigated by one clinician.

The project is selected from the project dialog which appears
when the project setup button is pressed

4| Select a project

Available projects

test

Identifier :
1D # : 0002

Mame : |7

Aims of this project:

(|

Responsible persons :

(|

Comments :

(|

Ok | Cance\‘ Help |

If you are collecting data to an already existing project, just select
the project name from the list and press OK or double click the
project name.

If you are defining a new project, select the item <new> from the
list and enter the project name and other reference information in
the text entry areas. The project name may consist of lowercase
letters and the underscore character. In addition to the project
name, aims, and names of responsible persons are required for the
definition of a new project.

NM23065A
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If you are changing to No project double click the item <new>.
If you want to close the project dialog without changing anything
press Cancel.

There are two useful keyboard shortcuts in the project list. First,
you can go to the <new> item by pressing the home key with con-
trol down. Second, you can browse the list alphabetically by
clicking any of the items and then pressing a letter key. The list
will move to the first project name beginning with this letter.

3.2. Subject

3.2.1. Subject list

Subject definition is analogous to the project definition. The
names of already existing subjects are listed alphabetically at the
top of the dialog.

If you are collecting data from an already existing subject, just
select the subject name from the list and press OK or double click
the subject name.

NM23065A
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To define a new subject, select the item <new> from the list, enter
the information to the text fields, select the appropriate choices,
and press OK. You are required to enter the first and the last name.
Do not to define the same subject twice as a double-entry may
confuse the MEG/MRI subject matching in the analysis pro-
grams.

Weight and height are optional whereas handedness and sex are
always taken from the corresponding option menus. Hospital
Information System (HIS) ID is intended for a hospital-wide
patient code, such as social security number, which uniquely
identifies the subject. HIS ID is stored with each data file and it
can be used as a path name component for the saved files.

If you are changing to No subject double click the item <new>.
If you want to close the subject dialog without changing anything
press Cancel.

The keyboard shortcuts in the subject list are identical to those in
the project list.

3.2.2. Volunteers and patients

Sites studying patients would often like to protect patient infor-
mation from unauthorized access. megacq provides a grouping of
persons to be studied to ‘volunteers’ and ‘patients’.

Volunteers are healthy subjects participating in the MEG studies.
When a person is classified as volunteer, megacq applies no spe-
cial protection on his data:

1. The personal data of a volunteer can be read by any user in
megacq. All personal information is included with the mea-
sured data.

2. The data will be saved - by default - in directories
<volume>/<project>/<last name>_<first name>/<date>,
as discussed in Section 6.1. on page 50. All directories on the
path are accessible to any user.

For a person classified as a patient, the following protective mea-

sures are taken:

1. Only the patient id number will be written to the data files.
The data files will contain case as the patient’s first name
and the id number as the last name. Therefore, if you list the
person’s name from a data file it will be something like
case_b67.

2. The data will be saved - by default - in directories
<project>/case_<id>/<date>.

3. The creator of the patient chooses the access restrictions
which apply to the personal data of the patient entered and to
the MEG and EEG data saved.

NM23065A
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In the strict access mode, the data are only readable by the
creator of the patient.

In the group access mode, read, and write access to the patient
data is additionally granted to a designated group of UNIX
users.

The choice between volunteers and patients is made in the option
menu at the top of the subject definition dialog. When the menu
is set to Volunteers, all volunteers are listed.

— Available subjects :

Zubject type : Volunteers —

Zubject name :

When the menu is set to Patients all patients accessible to the cur-
rent user are listed.

ilable subjects :

3 J_iectt-,-'pe: Patients r—
ssible to group: Mone r—

Alzheimer Albert A

If you have created the patient, the Accessible to group: option
menu becomes undimmed.

Available subjects :

Zubject t-,-'pe: Patients
ssible to group :

Alzheimer Albert A

If the choice is None the data of this patient are only accessible to
you (the user currently logged in). If you select a group of users,
the data become accessible to this group as well. Please consult
your system administrator if you need a new group of users. The
number of groups should be kept as small as possible.

Note: If you have restarted the acquisition software as described
in Section &, you can reuse earlier HPI data when megacq is re-
started. However, you can change the subject only once (from No
subject to some available subject) without losing the HPI data.

NM23065A

Setting up 10



Elekta Neuromag DATA ACQUISITION

3.3. Acquisition

The acquisition setup dialog, which appears when the acquisition
setup button is pressed, adjusts the following:

Channel selection

MEGDI18] MEG OTTE] MEG |:|111' MES E rEs oizl |

Tl 101 I

OFF [EEG ON [EEG OFF

Lowpass Highpass
7 de
B 010Hz: O

~ 1000 Hz

1. The selection of channels to be acquired.

The channels are switched on and off from the corresponding
buttons in the upper part of the dialog.

Note: All MEG channels are selected by default. Switching any
of them off should be done with caution. It is better to ignore mal-
functioning channels in the analysis software instead of not re-
cording them at all. This enables, e.g., checking if artefacts on
other channels are due to malfunctioning channel. In addition,
some third party analysis tools assume all channels to be present
in data file.

NM23065A Setting up 11
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The number of electric input channels is system specific. It is
typically 64.

Each of the electric channels can serve either as an EEG,
ECG, EMG, EOG, or a miscellaneous input. The type of each
electric channel can be changed from a popup menu attached
to each of the electric channel buttons. By default, holding
down the right mouse button while pointing to an electric
channel button brings up this menu.

Typically, EEG hardware channels 1 - 60 are unipolar and 61
- 64 are bipolar. Only the latter ones should be used as ECG,
EMG, or EOG channels. See “Elekta Neuromag System
Hardware User’s Manual” for description of the EEG hard-
ware.

The change of the input type only affects the channel name.
This is often useful in the artefact rejection and later stages of
data analysis. For example, xplotter, the plotting program,
may be set up to lay out the EOG channels in an invariable
way. Also, the scales of various electric channel types can be
separately set in xplotter and in the raw data display.

Channels labeled with STT are stimulus channels whose usage
is described in more detail in Section 3.4. on page 14. Chan-
nels labeled with MISC are auxiliary electrical input chan-
nels.

2. The sampling frequency.

The sampling frequency, f, is set with a slider below the
channel selectors.

The maximum allowed sampling rate depends on the data
acquisition hardware and on the selection of channels and
their actual distribution between the analog-to-digital con-
verters in the data acquisition unit. The maximum on the sam-
pling frequency slider automatically reflects the limitation
imposed by the hardware.

The actual sampling rate may slightly differ from the selected
one because of limitations in the hardware. However, the real
sampling rate is reported in the data files and in the informa-
tion window on top of the main acquisition window.

3. Low-pass filter

The low-pass filter corner frequency, f,, is set with a slider to

the right of the sampling frequency slider. The actual filter
corner may differ somewhat from this setting. The real corner
frequency is saved into data files and reported in the informa-
tion window. For more detailed low-pass filter specifications
consult the “Elekta Neuromag System Hardware Technical
Manual”.

NM23065A Setting up 12
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According to the Nyquvist criterion, the sampling frequency
should be at least twice the highest frequency component in
the analog signal, f, > 2f to avoid aliasing. Since analog fil-

ters cannot have an infinitely steep transition at the corner fre-
quency, megacq adds a safety margin and only allows f > 3f .

High-pass filter

The corner frequency of the high-pass filter can be set in
steps. The available corner frequencies are shown next to the
toggle buttons provided for selecting the filter.

Raw data baseline

With this option, it is possible to define the amount of data to
be saved preceding the time when raw data saving was
switched on. The length of this ‘baseline’ will be at least the
indicated amount. The maximum length is 15 seconds. This
feature allows keeping the raw data saving off until some-
thing interesting happens. When saving is activated, the event
noticed can be saved, even though it has already gone.

Use MaxShield feedback

This option is present only in systems using MaxShield™.
The toggle button is used to activate or deactivate the internal
feedback system. See “MaxShield User’s Manual”.

Note: Filters and gains of EEG amplifiers are controlled through
a separate control dialog, described in “Setting filters and gains of
electric channels” on page 30.

NM23065A Setting up 13
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3.4. Stimuli and triggers

The electrical stimulus triggers, that mark events for the acquisi-
tion software, can be provided either by the data acquisition unit
or by an external stimulation system. The acquisition software
processes the trigger signals exactly in the same way, independent
of their origin. This section describes the trigger system and gen-
eration of triggers.

3.4.1. Trigger interfaces and triggering modes

The electric interface of the trigger signals is called a Stimulus
Trigger Interface Unit, which is connected to the System Control
Card (SCC) housed in the data acquisition system cabinet. Elekta
Neuromag systems include two such interface units, which by
default operate in parallel, i.e. input #1 and output #1 on both
interface units correspond to trigger line #1 on the combination
trigger channel (STI101) associated with the 1st interface unit.
However, the two interfaces can also be treated separately by
turning on (selecting for acquisition) the trigger channel (STI102)
associated with the 2nd interface unit. This is done using the
acquisition setup dialog.

For details about the Stimulus Trigger Interface Unit and for elec-
trical specifications of the trigger pulses, see “Elekta Neuromag
System Hardware User’s Manual” and “Elekta Neuromag System
Hardware Technical Manual”.

The SCC manages both internal and external triggers. Irrespective
of the triggering mode (internal/external) the trigger pulses
always appear at the corresponding trigger outputs of both inter-
face units. The principle is shown in the following figure.

Triggers in Triggers out
RTCOin —»—F— 51 i
10 “ L 7\)@» RTCO out
>1 e
RTC1in —» 91 r g
16 “ e M? RTC1 out
In.ternal 16 Parallel / independent
trigger
Legend:
nerator
generato RTC: remote trigger interface

NM23065A
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Internally generated trigger pulses and the pulses acquired from
external sources are logically OR’ed line by line. The pulse is fed
to the acquisition system and to the trigger outputs. Thus the sys-
tem automatically ‘chooses’ the right source for each trigger
channel provided that a trigger channel is not receiving pulses
both from internal and external sources at the same time. Should
this happen, pulses from those two or three sources will be inter-
mixed and indistinguishable at further processing stages.

Typically the trigger event is associated with the rising edge of
trigger pulse, however, the off-line analysis tools can be config-
ured to also monitor the falling edge. Note that the timing of the
falling edge does not accurately reflect any physical event in sys-
tems which incorporate circuitry that fixes the pulse length.

The stimulus setup dialog shown below selects the trigger source
from the software point of view: if internal triggering is selected,
you are allowed to define a stimulus sequence.

If you prefer external triggering, turn the switch to the external
position and connect a TTL level trigger pulse output from your
stimulation system to the trigger input.

Note: Both internal and external triggers can be used in the same
session.

3.4.2. Stimulus sequence

The stimulus setup dialog appears when you press the stimulus
setup button.

~| Stimulus setup

# length/ms 151ims

LL-|

5: I

10: I

Load...| Save...| Generate...|

{® Internal stimulus generation

) External stimulus generation

Ok | Cancel Help
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Each item in the internal stimulus sequence is defined by the trig-
ger number (1 — 16), the length of the trigger pulse (ms), and the
length of the interval from the start of the trigger to the next. This
period is often called the inter-stimulus interval (ISI).

The maximum length of the sequence is 500 stimuli. The mini-
mum pulse length is 5 ms and the minimum ISI is 50 ms. There
must be at least 50 ms from the end of the trigger to the next.

The stimulus sequence can be either entered manually, generated
with help of the sequence generator, or loaded from a file.

3.4.3. Sequence generator

The sequence generator utility is accessed trough the Generate
button in the stimulus definition dialog.

Stimulus sequence generator

You can create several kinds of sequences:
1. An alternating sequence

Given number of stimuli, n, are repeated sequentially:
1,2,...,n,1,2,...,n,... If the ISI limits are equal, the ISI remains
constant; if they are different, the ISI’s are random within the
interval with a uniform probability density.

2. Random sequence

The given number of stimuli have an equal probability to
occur in the random sequence. The handling of ISI’s is the
same as in the alternating sequence.

3. Mismatch sequence

Rare (deviant) stimuli occur randomly with given probability
in a monotonous sequence of standard stimuli. If the deviant
probability is less than 15 percent, two deviant stimuli will
never occur sequentially. Normally stimulus 1 is the standard
and stimulus 2 the deviant. If the deviant probability is set to
higher than 85 percent, the roles of the stimuli are reversed.

NM23065A Setting up 16
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Once you click Generate, the sequence is generated and the val-
ues are entered into the stimulus sequence table.

3.4.4. Loading and saving sequences

You can load stimulus sequences from text files and save existing
sequences for future retrieval. By default, the stimulus-sequence
files are stored in the directory /neuro/dacqg/stim.

You can also generate sequence files yourself either with a text
editor or with a program. The sequence file simply replicates the
sequence table:

<trigger #1> <length 1/ms> <ISI 1/ms>
<trigger #2> <length 2/ms> <ISI 2/ms>

Space, tab, and newline are allowed as separator characters
between the numbers. Although megacq writes the data three
numbers per line to mimic the layout of the table, you can store as
many numbers per line as you like as long as they are separated
by one or more of the separator characters.
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3.5. On-line averaging

3.5.1. Basics

The most complex part of the acquisition setup concerns on-line
averaging. For the discussion to follow we need to define a few
relevant concepts first.

Trigger channel

An electric impulse carrying solely timing information and
occurring on a single digital line is called a trigger. A trigger
could be used to drive a stimulator to produce a stimulus, or
it could reflect subject’s behavioral response. Triggers are
generated by the system described in Section 3.4.1. The out-
put of that system controls the on-line averager.

The system has several trigger channels for recording trigger
pulses. STI1 to STI16 contain analog-like signal of a single
trigger line and are provided for backwards compatibility.
STI101 and STI102 carry bit combinations describing state of
the two interface units. Each bit corresponds to one of the
trigger lines of the boxes. STI201 carries bit combinations for
triggers generated by internal events, like HPI and phantom.
STI301 is a reference channel used in tuning.

Event

A transition from an inactive to active state or vice versa on
one or more trigger lines is an event. The source of an event
can be either a stimulus trigger or a trigger associated with an
action performed by the subject, such as a button press.

To avoid misinterpretations of the trigger combinations due
to race conditions, the following procedure is implemented in
the on-line averager. Assume sample k with all trigger lines
inactive followed by sample k£ + 1 having one or more active
trigger lines. Sample k + 1 1s used as the timing reference, but
the trigger line combination is determined from sample & + 2.
This allows a slight asynchrony between the on-sets of the
trigger lines.

Epoch

An epoch is a section of the incoming continuous data,
defined by the occurrence of an event and the time limits 7__

andz__ with respect to that event. We will call the event deter-
mining the zero time of an epoch a trigger event.

Category

A category defines the epoch to be averaged, any additional
conditions to averaging, and the processing of epochs during
averaging. For example, some categories may be set up to
produce, in addition to the standard average, several subaver-
ages of, say, eight consecutive epochs each.

NM23065A
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3.5.2. Online averaging dialog

The on-line averaging dialog appears when you press the on-line
averaging button. The events are defined in the top part as
described in Section 3.5.3. The categories are defined in the mid-
dle part as described in Section 3.5.4. The artefact rejection and
miscellaneous settings are defined in the bottom part as described
in Section 3.5.5, Section 3.5.6, and Section 3.5.7
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3.5.3. Events

The Event characteristics section in the top part of the on-line
averaging dialog is used to define the events used in averaging.
There are 32 event lines, each of which contains a Change... but-
ton and a description of the event properties.
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The dialog appearing from the Change... button contains the fol-
lowing controls.

Characteristics of an event:

Mame: Channel: |5TH01 —

Value . =010z

O I

oo C (I o0 oo o
Delay to stimulus (ms) _

Name:

A text field to enter a descriptive name for the event. Spaces
are not allowed.

Channel:

An option menu to select a combination trigger channel.
Old Value/Mask and New Value/Mask:

These fields define the trigger channel state transition that is
mapped to this event. The Old fields define the state of the
triggers before the transition, and the New fields define the
state after the transition.

First Old Value and previous bit combination are logically
anded with Old Mask. If the resulting values are equal, then
New Value and next bit combination are logically ANDed
with New Mask. If the resulting values are again equal, then
transition is considered to have taken place.

Bit 01 corresponds to trigger line 1 and so on. Each Value/
Mask pair can be entered directly as two decimal bit combi-
nation values. Alternatively each bit can be toggled sepa-
rately such that ‘0’ changes to ‘1°, ‘1’ to **’, and “*’ back to
‘0’. Asterisk stands for don’t care and is added to Mask.

Delay to stimulus:

A text field used to enter a delay (in ms) from the trigger state
transition to the actual stimulus. For example, if you have
plastic tubes with known transmission delays leading audi-
tory stimuli to the subject’s ears, enter the delay here to set the
time scale of the responses correctly. The delay must be
defined positive if the stimulus occurs after the trigger and
negative if it occurs before the trigger.

Name:

A text field to assign a comment to the event.
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For backwards compatibility, the default definitions of the events
correspond to the transitions on the trigger lines as follows (Old
Value/Mask is set to 0/63 and New Mask is set to 63):

Event # Trigger lines to activate

I 1

2 2

3 3

4 4

5 5

6 6

7T 1&2

8 1&3

9 2&3
10 1&2&3
11 1&4
12 2&4
13 1&2&4
14 3&4
I5 1&3&4
16 2&3&4

17 1&2&3&4

Note: As described in Section 3.5.1, event numbers do not di-
rectly relate to category numbers. For example, event # 1 may be
used as a trigger in several categories, not necessarily including
category # 1. Therefore, if you adjust the delays of some events,
keep in mind that event # 5 is not always triggering category # 5.

3.5.4. Categories

The Averaging categories section in the middle part of the on-
line averaging dialog is used to define the categories to be aver-
aged. There are 32 category lines, each of which contains the fol-
lowing items:

On-off toggle

A toggle button to activate and deactivate a category. You can
often define all categories you need in a study consisting of
several consecutive acquisitions and then just switch the cat-
egories on and off as needed.

Display on-off toggle

This toggle button sets the on-line display state of a category.
The states of these buttons define the initial selection of cate-
gories displayed in the xplotter window during averaging.
The selection of displayed data can be modified during acqui-
sition as discussed in Section 5.4.4. However, when the
acquisition is finished, the final results from any categories
which have one or more epochs averaged will be displayed
regardless of the on-line display selection. Note also that any
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changes made to the on-line display selection during the data
collection will remain in effect for the subsequent acquisi-
tions.

Change...

This button invokes a dialog to define the characteristics of a
category.

Description
A text describing the properties currently selected for this cat-
egory from the category definition dialog.

The dialog appearing from the Change... button contains the fol-
lowing controls:

Edit category 1

Parameters of an averaging category:
Ref. event: I 1(1)  r—  tmin(rr
Feg. event: I Mone before —  Within (ms) _

Desired # of averages : | i Subave. size : _
Ll | Category # 1

I Cancel

Ref. event:

An option menu to select the trigger event. The event is con-
sidered as the zero-time point, with the optional stimulus
delay compensation taken into account (see the previous sub-
section on Events). The event name list reflects the defined
events in the top part of the on-line averager window.

tmin:

The start time of the averaging window with respect to the
reference event. This value can be negative (prior to the
occurrence of the reference event) or positive (after the occur-
rence of the reference event).

tmax:

The end time of the averaging window with respect to the ref-
erence event.

Req. event:
An option menu to select the condition event. If None is
selected, there is no condition.

When:
An option menu to select Before or After. If Before is
selected, the condition event must occur before the trigger

event. In case of After, the condition event must occur after
the trigger event.
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Within:
The time range within which the condition event must occur
in order for an epoch to match this category.

Desired # of averages:

If this number is zero or negative, the number of epochs aver-
aged is controlled manually, see Section 5.1. on page 37.

If the setting is positive, averaging is automatically sus-
pended when the desired number of averages is reached. You
can then either continue averaging manually or stop the mea-
surement.

If several categories have the desired number of averages set,
the first one to reach the limit causes the averaging to be sus-
pended. Other limits not satisfied remain active. Therefore, if
you continue averaging manually, the averaging will be again
suspended if some other category reaches the limit.

Subave. size:

If this number is set to M > 0 both normal and alternating sub-
averages are computed consisting of M epochs. If we denote
the epochs by ¢,(1), the jth normal and alternating subaverages

are
iM
e;(r) = D e,(t)and
k=1+(-1)M
iM
- k+1
=Y (D" e,
k=1+(-1)M
respectively.

Note: M should be an even number to get proper alternating sub-
averages.

Comment:

A text entry field to annotate a category with a comment. The
comment is shown when new data are loaded for plotting and
source modeling.

3.5.5. Artefact rejection

There are three kinds of artefact rejection criteria available for
MEG and EEG channels. Each of these can be turned off by enter-
ing a negative number into their control field.

Amplitude (Max)

The peak-to-peak amplitude within an epoch must not exceed
this value. Recommended value 1s 3000 fT/cm for gradiome-
ters and 3000 fT for magnetometers.
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Slope

The epoch is subdivided into four equally long pieces. The
averages over each piece is calculated. None of the three dif-
ferences between subsequent partial averages must not
exceed this value. By default, this criterion is not in use.

Spike

The absolute value of the difference between any sampled
value in an epoch and the average of 20 previous values must
not be larger than this. By default, this criterion is not in use.

The above criteria are applied to all MEG and EEG channels. If a
channel not meeting the criteria throughout the epoch is found,
the epoch is rejected. Some channels can be excluded from the
artefact rejection during acquisition, see Section 5.4.3.

EOG, EMG, and ECG rejection is only possible on the basis of the
amplitude criterion.

In addition to the above criteria, an epoch up to a given time inter-
val after the reference event can be excluded from the rejection
(Ignore (ms) after stim). This is useful if a strong stimulus arte-
fact is expected.

3.5.6. Noisy and silent channels

The above artefact criteria are applied in a transient manner.
Every epoch is checked against the above criteria to see whether
the conditions can be met. However, it sometimes happens that
few MEG channels are either showing no signal or are very noisy.
There are two additional parameters to check these channels:
MEG no signal and MEG noisy.

If the peak-to-peak amplitude of a channel is less than the MEG
no signal limit or larger than the MEG noisy limit, the channel
will be omitted from further artefact checking during the current
and all subsequent epochs. The noisy and silent channels so
detected will be marked ‘bad’ in the resulting evoked-response
data files.

The signals of “noisy” or “silent” channels are stored in the very
same way as those of any other channels; the automatic detection
only affects rejection checking.

3.5.7. On-line display updates

During on-line averaging the progress is displayed by showing
data averaged so far in the standard plotting program (xplotter).

By default this display is updated every 60 seconds. You may
want to set this value higher in order to work with the data
between updates. It is also advisable to set the update interval
higher if the ISI is small (< 500 ms), if the sampling rate is high
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(> 1 kHz), the epochs are long (> 2 s), or if many categories are
selected to the on-line display. If the updates are too frequent, the
on-line averaging may not proceed in real-time and, conse-
quently, you may have to wait at the end of the acquisition for on-
line averaging to complete.

3.6. Head digitization

In order to be able to locate signal sources relative to the head, one
must know the position of the head within the probe. For this pur-
pose we use a head position indicator (HPI) system. Before the
measurement, one attaches small coils to the head and digitizes
their locations on the head. These coils are then used during the
measurement to measure the location of the head. Following sec-
tions describe the coordinate systems used and how the digitiza-
tion is performed.

3.6.1. Coordinate frames

The Elekta Neuromag systems internally use device coordinate
system. The recorded signals represent field components at fixed
sensor locations in the device coordinate system. The origin of
this coordinate system is located at the center of the posterior
spherical part of the helmet with x-axis from left to right, y-axis
pointing from back to front, and z-axis pointing up. Thus the posi-
tion of subject’s head in respect to the measurement probe does
not affect the way the signals are recorded.

Source modeling calculations are also done in the device coordi-
nate system. However, the results are automatically transformed
into a more relevant coordinate system, namely into the head
coordinate system (also called the anatomical coordinate system).
This is essential in order to integrate the source model into an ana-
tomical image, e.g., magnetic resonance image.

The head coordinate system is defined as follows: The x-axis
passes through the preauricular points with positive values on the
right, the y-axis will be perpendicular to the x-axis, passing
through the nasion and the positive axis pointing towards the
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nose, and the z-axis will point up, perpendicular to the xy-plane.
This is illustrated in figure below. LPA and RPA stand for the left
and right peri- or preauricular points, respectively. LPA, RPA and
nasion are called the anatomical landmarks or cardinal points.

<

A

RPA

Yy , I
Nasion L PA

To establish the coordinate transformation between the head
coordinate system and the device coordinate system the anatomi-
cal landmarks have to be expressed in the device coordinate sys-
tem. This is done indirectly by using HPI coils whose locations
can be measured with respect to the anatomical system and also
with respect to the device coordinate system. The former mea-
surement is called Head digitization and the latter HPI measure-
ment. The combination of these two measurements results in a
coordinate transformation between device coordinate system and
head coordinate system.

3.6.2. Digitization

The final task before starting the measurement is the digitization
of the anatomical landmarks on the head and the position of the
HPI coils with respect to them.

When you click the HPI CHANGE... button, megacq connects to
and initializes the 3D digitizer (also referred as “Isotrak™ in the
software) used for this purpose. Digitizer initialization takes a few
seconds. You are informed about this in a dialog. Once the initial-
ization is complete the HPI dialog appears.
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Head shape digitization
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The left section of the dialog contains the controls for the tasks
which are necessary to complete the HPI procedure. The lower
right section contains controls for optional items. The label above

the dialog buttons will dynamically indicate the task to be per-
formed next.

The operation of the digitizer, and how to attach HPI coils are

described in more detail in “Elekta Neuromag System Hardware
User’s Manual”.
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Proceed as follows with the digitization:

1. Attach the HPI coils on the head. Typically the coils are
placed so that two are behind the ears as high as possible
without being on the hair, and two on the forehead well sepa-
rated but not on the hair. The system does not restrict the coil
locations provided that they are covered by the MEG sensor
array and do not move during the measurement. The most
precise HPI information is obtained when the coils are as far
apart as possible but still within the sensor helmet. Try avoid-
ing situation where coils form a nearly perfect square.

2. The digitization system is equipped with goggles which track
head movements during the digitization. Place the goggles
firmly on the subject’s head and tighten the strap. Check that
nasion and the coil centers are still accessible with the Isotrak
stylus.

3. Make sure the digitization chair is sufficiently far (over 1.5
m) from large metal objects as they severely distort the digi-
tizer and compromise its accuracy. Tell the subject to avoid
excessive head movement.

4. Digitize the anatomical landmarks: the nasion and the two
auricular points. Depending on your preferences you may use
either peri-auricular or pre-auricular points. Be sure to record
which points were used to be able to correctly identify them
later on the anatomical MR images.

To digitize, position the tip of the 3D digitizer stylus at the
desired point and click the corresponding button in the HPI
dialog. It is best to have two people available for the digitiza-
tion: one to position the stylus and another to operate the pro-
gram. Alternatively, the stylus button can be used for the
digitization: click the Coordinate frame alignment button to
start the “single operator’” mode. Then digitize the landmarks
in any order; the system will automatically associate the
points with proper landmarks.

The coordinates next to each button indicate the digitized
position in a coordinate frame tied to the signal source of the
digitizer behind the chair. The results are averages of three
sequential readings taken from the digitizer. If they differ
from each other by more than 2 mm, an error message telling
to keep the pointer steady appears and you can re-digitize the
point.

5. When the digitization of the cardinal points is complete, press
the Align frame button (the alignment is done automatically
when operating with the stylus button and all three landmarks
are digitized). The coordinates of subsequent readings will be
given in the head coordinate frame, tied to the cardinal land-
marks.

When Align frame is pressed, the coordinates of the cardinal
locations will change to the head frame. Notice that the z
coordinates of all three points are zero. The y coordinates of
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the auricular points are zero with a positive x coordinate on
the right and a negative on the left auricular point, respec-
tively. The nasion has a zero x coordinate and its y coordinate
is positive. The auricular points are usually rather symmetri-
cally located: their x coordinates are opposite and about of
equal magnitude. This serves as an additional check that the
digitized values are reasonable.

6. Digitize the HPI coils (order does not matter).

7. 1If scalp EEG channels are selected for acquisition, the pro-
gram moves on to digitize the EEG electrode locations. Alter-
native electrode digitization sequences for different EEG
caps can be configured; the proper one can be selected in the
EEG digitization quadrant of the window. The default is to
digitize in the ascendant channel number order, starting from
the reference electrode.

8. You can digitize additional points to obtain information about
the head shape, which allows more accurate alignment with
the anatomical MR images. Press Man to digitize the location
of the stylus in the “two operator” mode or Pen to use the sty-
lus button. Select one or more of the digitized extra points
from the list and press Delete to remove unneeded entries.
Select two points in the list and press Dist? to find out the dis-
tance between the selected points. The coordinates of the
additional points will be included into the measurement files.
Once you have completed the digitization, press OK.

The digitization procedure and other pre-measurement setups can
be performed also on a workstation other than the acquisition
workstation even when there is a measurement in progress. See
“Experiment preparation” on page 35 for more information.

Note: If you press Cancel in the dialog you will loose all the dig-
itized data. A warning dialog will appear to confirm this.

3.6.3. Using five coils

By default systems are configured to use three or four coils. If five
coils are used, variable DEFisotrakNcoil in file
/neuro/dacqg/setup/megacqg.defs.local should be
set to 5.

3.7. Gantry position

Before starting a measurement, one should make sure that Gantry
position in the megacq main window reflects the current dewar
position. The adjacent gantry position setup button can be used to
change the position label to Upright or Supine. See Section
3.10.2. “Setting up for on-line SSP” on page 33 for more details.

NM23065A

Setting up 29



Elekta Neuromag DATA ACQUISITION

3.8. Saving and restoring settings

All of the above settings apart from the project and subject data
can be saved between sessions. There is a separate set of settings
for each project. Therefore, you cannot save or load settings until
the project is selected.

Settings are saved and loaded from the Save settings... and
Load settings... items in the File menu. When you save settings
you must provide a descriptive name for the setup. This name is
shown in the list of available settings when you load the settings
back later.

The settings are also included with the measured data. By choos-

ing Load measurement settings... from the File menu you can

locate a data file and load settings from there. This option is useful

if

1. You would like to replicate a measurement with identical set-
tings.

2. You would like to check the actual settings used afterwards.

Note that the Head digitization data (see Section 3.6. on page 25)
are not stored in the settings nor can they be loaded from a data
file. On the contrary, subject preparation information includes
everything that is in the settings as well as the digitization data.
You can create a preparation from the current setup and digitiza-
tion by choosing Save preparation from the File menu and recall
it later by choosing Load normal preparation... from the same
menu. See Section 4. on page 35 for more details.

Button Load playback preparation... is used only in systems
where data may need to be stored and “played back*.

Note: EEG amplifier settings are not saved in the settings files
described in this section. For saving and loading amplifier set-
tings, see Section 3.9.

3.9. Setting filters and gains of electric channels

The electric channels, like EEG, have a separate control dialog
which allows setting of gain, high-pass filter, and various other
parameters of the electronics. See “Elekta Neuromag System
Hardware User’s Manual” for more information about the EEG
electronics.

For adjusting the electric channels, use the Squiddler-EEG utility
program which can be invoked from the Tools menu of the
Acquisition control program. The control dialog is shown below.
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EEG control

File Misc Commands

On the top of the dialog there is a menu bar which allows:
Loading and saving of the settings.

Opening and closing connection to the electronics controller
“Janitor_eeg”.

Accessing channel list dialog, which is an alternate way of
selecting channel to be adjusted.
Reloading data to the electronics, e.g., if power has been off.

Requesting miscellaneous information from the server for
debugging purposes.

Below the menu is a channel selection area, which contains a text
box and a slider. Both can be used to select the channel to be
adjusted. All channels can be adjusted by pressing ALL button.

Below the channel selection area are control buttons for two sets
of parameters. The upper ones are affecting the selected channel,
while the lower ones are always affecting all channels.

Note: All EEG amplifiers that are not in use, should be turned
off to avoid disturbances.
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Per-channel parameters:
- Active: Selected preamplifier (or all preamplifiers) on/off.

- Gain: Select 5000 / 500 / 150 (nominal gain, actual value
taken into account via the calibration coefficient. Value in
parenthesis indicates maximum peak-to-peak signal to elec-
trode input. Normally 5000 for unipolar EEG channels, 500
or 150 for bipolar channels (EOG, EMG, etc.). Nothing is
shown in the ALL mode.

- HPF: Hardware high-pass filter -3 dB corner frequency.

- Test Osc +input: Connect the internal test oscillator + signal
to the + input of this channel. Used both for bipolar and uni-
polar channels. Test Osc must also be on (see below) to use
the test signal.

- Test Osc -input: Connect the internal test oscillator - signal
to the - input of this channel. Used for bipolar channels
together with Test Osc + input. Leave off when testing uni-
polar channels. Test Osc must be also on (see below) to use
the test signal.

Common parameters:

- Ref Source: Select reference electrode, Wilson Central Ter-
minal (WCT, computed average of unipolar channels 1-3) or
isolated signal ground of the preamplifiers. See “Elekta Neu-
romag System Hardware User’s Guide” for explanation of
terms.

- Ref Test Osc: Connect test oscillator signal to reference
electrode input. Test Osc must also be on (see below) to use
the test signal.

- Active ground: Connect AC signal from reference electrode
to isolated signal ground driver.

- Test Osc: Test oscillator on/off. To use the test signal, the
connection to individual channel inputs (see above) must also
be enabled.

- Test Osc Freq: Test oscillator frequency.

- Test Osc Amp: Test oscillator amplitude (nominal value at
input assuming terminator block with 1-MOhm impedance
connected).

To enable the test signals from the built-in signal generator click
the ALL button, then click Test Osc +input and finally Test Osc
On. There should be a clean sinusoidal wave of equal amplitude
on all EEG channels. Every other channel should be 180 degrees
out of phase (the test signal feed is inverted, not the input).

Note: The internal test oscillator is intended only for routine
qualitative calibration checking, accurate calibration is performed
by an authorized service engineer.

NM23065A

Setting up 32



Elekta Neuromag DATA ACQUISITION

3.10. On-line signal space projection

3.10.1. Background

External magnetic disturbances which have fairly uniform distri-
bution but varying amplitudes can be suppressed by the signal
space projection (SSP) technique.

The measured signals span a signal space whose dimension
equals the number of channels n being measured. Thus, at each
sampling point in time, the signals can be described as a vector in
the signal space. For a given distribution or field topology the sig-
nal vector points to the same direction but its length varies as the
amplitudes of the signals change. Once the distribution(s) corre-
sponding to a disturbance are known a suppressing SSP operator
can be constructed from the distributions (refer to the Signal Pro-
cessor Reference Manual for details). The operator ‘rotates’ each
sample vector in the signal space so that the disturbance becomes
orthogonal to the n-1 dimensional hyperplane in the signal space
and thus disappears. The drawback is losing one degree of free-
dom, i.e., one independent measurement, and the slight deforma-
tion of response patterns if viewed without a subsequent
reconstruction.

Since the topology of external disturbances at a particular site is
typically constant to a good approximation, it is not necessary to
define the SSP operator individually for each measurement, if the
magnetometer probe is at a fixed location and orientation.

3.10.2. Setting up for on-line SSP

Depending on dewar position, SSP operator contained in either
/neuro/ssp/online_supine.fif

or
/neuro/ssp/online_upright.fif

will automatically be included in all raw data and average files
measured by the system. If that file doesn’t exist or if it doesn’t
contain an SSP operator, the on-line SSP is silently turned off.
The Signal Processor Reference Manual includes instructions for
defining the projection and creating the file mentioned above.

Note that the data are always stored intact, but the operator is
optionally included in the data file, so that various data viewers
and analysis programs can take it into account, or at request, show
the non-projected original data.
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3.10.3. SSP and the on-line averager

Since averaging and projection are both linear operations and thus
commute, projection can be done only to the final average. The
on-line averager attaches the SSP operator to the output average
file but leaves the actual signal intact, i.e., un-projected. The visu-
alization software is responsible for applying the SSP operator to
the data.

The rejection checking of the on-line averager, however, uses
SSP-filtered data.

NM23065A Setting up 34



Elekta Neuromag DATA ACQUISITION

4. EXPERIMENT PREPARATION

As discussed in Section 3.8, the acquisition and averaging param-
eters can be saved between sessions using the Save settings...
and Load settings... items in the File menu. Therefore, a given
experimental paradigm can be easily repeated.

It is often beneficial to save all measurement parameters, includ-
ing the project and subject selections, all acquisition and averag-
ing parameters, and the head digitization data for subsequent use.
This complete set of information is called a preparation.

4.1. Restricted megacq

An experiment can be prepared either from the standard megacq
or from its restricted version. The restricted version is started by
double clicking the PrepareAcquisition icon in the Neuromag
toolbox.

= }‘)’,

/
Preparefcouisition

| File On-line Tools:

Settings
Change | Project: not specified!
Change | Subject: not entered!
Change | Acquisition: 0,10 .. 330 Hz @ 1000.0 Hz, 309 channels, MaxShield Cn
Change | External stimulus generation,
Change | On-line averaging: not active.

1 Change | HPI: not digitized!

The restricted megacq does not communicate with the acquisition
system, and the acquisition control buttons (see Section 5.1) are
absent. A new experiment can be prepared from another worksta-
tion while data are being collected at the acquisition workstation.
The experiment preparation workstation has to be located near the
digitizer for feasible digitization.

Note: You can also use the restricted megacq to check informa-
tion about a subject or a project during off-line analysis without
disturbing the measurement.

4.2. Saving a preparation
Before you can save a preparation, you will have to complete the
following steps:
1. Select a project

2. Select a subject
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3. Enter the acquisition, stimulus, and averaging parameters or
load one of the settings available for the selected project.

4. Perform the head digitization.

With all the above data complete you can save the preparation by
selecting Save preparation from the File menu. If some of the
required data is missing an error dialog will appear. If all data is
present, the preparation will be saved. You will be informed about
the name given to the preparation. The name is of the form

<project name> | <subject name> | <date> <time>.

A saved preparation will be kept for 24 hours from its creation
time. Whenever megacq or its restricted version is started, the
preparation database is checked for old preparations which are
automatically discarded.

Note: Using the head digitization data from the preparation is
only meaningful if the HPI coils are kept attached on the subjects
head from the preparation time to the actual measurement.

4.3. Loading a saved preparation

When Load normal preparation... is selected from the File
menu, a list of available experiment preparations will appear. You
can easily identify the desired one from the descriptive name.
Please be careful to select the correct one. There is no way for the
program to check that the subject to be measured is the one you
claim him/her to be.

If necessary, you can override any of the data in the preparation
simply by redoing the relevant parts of the settings. For example,
you can redo the head digitization, if there is any doubt that the
HPI coils are not at the same positions as they were at the time of
the preparation.
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5. ACQUISITION

Once the setup is complete, subject is seated under the magnetom-
eter, the HPI coils and EEG electrodes have been connected as
described in the hardware manual, and the shielded room door is
closed, you can start the actual acquisition.

5.1. Acquisition controls

The acquisition control buttons are:

Acquisition controls

_lAversge | Hecordmmw ekl Slop

A

GO! | Btimuints
1. 2.

1.

|
Lo N “. Ja O.
GO!/Restart

Press GO! to Start the acquisition. If the parameters have been
changed or if this is your first acquisition, the acquisition sys-
tem is informed about the new parameters first. Thereafter,
the magnetometer electronics is set to the correct state includ-
ing analog filter settings.

Depending on the changes needed this procedure may take
about 5 - 10 seconds. The log window shows messages about
the conversation with the data collection server. Once the
setup is complete, a New measurement is starting... mes-
sage appears on the first message line below the acquisition
control buttons.

When data collection is started, this button changes to
Restart. You can then restart the acquisition by clicking this
button. All raw data and on-line averages collected will be
discarded and you can redo the head-position indicator mea-
surement (see Section 6.2).

Stimulate

With internal triggering, the button is enabled when data col-
lection is started. You can then switch the internal triggers on
and off by clicking this button. If you are using external trig-
gering, this button remains dimmed.

Average

With at least one active category, the button is enabled when
data collection is started. You can then switch on-line averag-
ing on and off by clicking this button. If there are no active
averaging categories, this button remains dimmed.

Record raw

Recording of raw (spontaneous) data is independent of on-
line averaging. You can switch the raw data recording on and
off at will during the acquisition. The amount of data col-
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lected in seconds and megabytes as well as the space remain-
ing on the acquisition hard disk is displayed on the second
message line of megacq.

5. cHPI

This button is enabled when a normal HPI is done. You can
then switch continuous HPI on and off by clicking this button.
If HPI is not digitized or you have decided to omit HPI local-
ization, this button remains dimmed. See also “Continuous
HPI” on page 40.

6. Stop

Stop the acquisition, see Section 5.7.

Sometimes it might be necessary to reset the MEG and EEG chan-
nels after an excessively strong magnetic or electric disturbance.
This can be done while a measurement is in progress by selecting
Reset channels from the Tools menu. On-line averaging and
raw data recording should be turned off before doing reset and
they should be kept off until all the channels have settled again.
Otherwise the data could be spoiled by the huge signals involved
in the reset operation.

Note: The extent to which the EEG channels are reset depends
on the configuration of the site. If the EEG system is controlled
completely independently of the Neuromag system, the reset ap-
plies only to the digital high-pass filters in the data acquisition
system, and thus is probably not sufficient to recover a saturated
EEG channel. Should this happen, first reset the EEG amplifier
system and after that use Reset channels to make the channels
to settle faster. Refer to the installation-specific technical docu-
mentation for details.
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5.2. Head position indicator

If you have digitized the HPI coil locations as described in Sec-
tion 3.6.2, you can localize subject’s head with respect to the
neuro-magnetometer. Normal HPI measures the head position at
the beginning of the measurement. The result is saved into the
data file. Continuous HPI allows determining the head position
during the measurement. This requires extra processing of the
data file after the measurement is completed.

5.2.1. Normal HPI acquisition

If the HPI coils have been digitized, the system automatically
pops up an HPI measurement dialog when data collection is
started. This dialog gives you the following choices:

Measure

Measure the magnetic field generated by current fed into the
HPI coils and determine the location of each coil. During the
measurement you will see messages on the last message line
of the megacq main window. If no signals are seen or if they
are considered too noisy, you will get an error message.
Should this happen, check that the coils are properly con-
nected and that the coils are working properly by rechecking
them with the HPI coil tester.

Once the measurement is complete, the positions are fitted.
When the fit completes, the results are reported as described
in Section 5.2.2 below.

The HPI procedure takes usually less than 10 seconds.
Reuse

If you have measured and fitted the HPI signals previously
with this Isotrak measurement, you can reuse the previous
data. Use this option with caution. If you have any doubt that
the head has moved since the last HPI measurement, use the
Measure choice instead.

Omit
Do not perform HPI localization at all.

5.2.2. HPI fitting

When the HPI signals have been acquired, a fitting program is
started to find out the locations of the coils. HPI fitting takes from
three to ten seconds. When the fitting is complete, you will see a
dialog with the following information:

1. Locations of the HPI coils in the device coordinates (see Sec-
tion 3.6.1 for the definition).

2. The goodness-of-fit value for each coil with an indication of
acceptance.
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3. Distances between the coils as measured by the digitizer.
Distances between the coils from the fitting procedure.

5. A list of discrepancies between the distances measured by
Isotrak and calculated from the fitting procedure. Distances
larger than 5 mm are indicated, suggesting a need to redo the
HPI measurement.

6. Location of the head coordinate system origin in device coor-
dinates.

7. Suggestion from the fitting program to accept or reject this
result.

With the above information you can easily decide whether or not
you should accept the data.

With the buttons at the bottom of the dialog, you can either accept
the HPI data, redo the measurement, or omit HPI localization.

Note: If you stop the acquisition and you have neither accepted
nor discarded the HPI result, no HPI data will be available in the
files produced when you save the data.

5.2.3. Continuous HPI

The system also supports recordings with continuous HPI (cHPI).
Using continuous HPI requires that a normal HPI measurement is
performed at the beginning of the measurement. When this has
been done, the cHPI button becomes available, and the user can
activate the HPI coils. This will lead to a measurement which con-
tains both the brain signals and the cHPI signals.

In order to judge the data quality during the cHPI measurement, a
low-pass filter should be used in the raw data display. By setting
the filter corner frequency suitably, the cHPI signals can be fil-
tered out from the data being displayed.

On-Line averaging can in principle be performed during a cHPI
measurement, but currently there are some problems which limit
its feasibility. The strong cHPI signals render artefact rejection
almost useless and, with the limited time span available, filtering
out the cHPI signals from the average is not as effective as with
continuous data.
The cHPI data is post-processed using MaxFilter-2.0 to

Extract the head position as a function of time

Remove the cHPI signals

Realign the data to correspond to a fixed head measurement

Average the data off-line

For details, see “MaxFilter-2.0 User’s Guide”.
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5.3. Raw data display

During acquisition the incoming data are displayed in a window
positioned to the right of megacq by default.
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STIOE
STI003
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3TIMS
ST16

| Av |l | Selectic_m....‘ R-ack-l Scales...‘ C_olors;..‘ﬂ Window: 3.0s -

| [MEG 01-02] Buffer 177.29s...

The length of the displayed raw data segment can be set to be a
small multiple of data buffers. The exact length depends on the
sampling frequency and the number of channels acquired.

The name of each channel shown is indicated to the left of each
trace. Vertical lines are shown at a selectable spacing for time ref-
erence. The events detected on the stimulus input channels are
also shown by vertical lines if any of the stimulus input channels
are selected to the display.
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STIME

5.3.1. Controls

The following controls are located at the bottom of the window:

STI1E

| ﬂj Il | Selection...‘ Rackl 'S'cales...‘ Color'&..‘ﬂ Window: 3.0s -

| [MEG 01-02] Buffer 177.29 s...

1.

Channel selection buttons.

When you press the left or right arrow buttons the display
shows the previous or next set of channels, respectively.
Channel selections are discussed in detail in Section 6.3.2.

Pause (ll)

The raw data display is frozen, but the acquisition still contin-
ues. When the raw data display is frozen you can still move
through the channels with the channel selection buttons.

Selection...

This button invokes a dialog showing the currently selected
MEG channels in graphical form. The shortcut buttons to go
to a desired selection are also located here.

Rack

When this toggle button is depressed the MEG channel num-
bering changes to electronics rack order. This feature of obso-
lete, since in Elekta Neuromag both orders are the same.

Scales...

When you press this button a dialog appears to change the
scales of various channel types and the spacing between ver-
tical time markers.

Colors...

When you press here a color definition dialog is shown to
change the colors of the components of the display.

Xy
An oscilloscope-like display for sensor tuning pops up with
this button.

Window
An option menu for selecting the length of the displayed raw

data segment in seconds. The choices are small multiples of
data buffers (e.g. 1, 3, 5 and 8 seconds).

NM23065A

Acquisition 42



Elekta Neuromag DATA ACQUISITION

5.3.2. Channel selections

When you press the Selection... button in the raw data display
controls the window shown below appears.

Zelections

The graphical display on the left indicates the currently selected
channels. The buttons on the right list the available selections
with descriptive names. There are two add-on selections available
to include additional channels to each selection:

Fixed electric

The first two electric (EEG, EOG, EMG, or ECG) channels
are added after the currently selected channels.

Stimulus

Switch on/off displaying of stimulus trigger channels (signals
labelled as STI...).

Show layout
The channel layout on the left can be hidden with this func-
tion to make the selection window smaller.
If you are not happy with the standard selections, you can custom-
ize them in the following way:

1. Copy /neuro/dacq/setup/rawdisp.sel to the directory
.meg_analysis under your home directory
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cp /neuro/dacqg/setup/rawdisp.sel ~/.meg_analysis/
2. Editfile ~/ .meg_analysis/rawdisp.sel with a text editor.

Each line in this file corresponds to a selection. The format of
each line is:

<selection name>:<ch name 1>|<ch name 2>|...

For example:
My selection:MEG 001 |MEG 002 |MEG 003

The channel names are identical to those listed in the channel
selection dialog, see Section 3.3. on page 11.

5.3.3. Scales

The vertical scales can be controlled by the Scales... dialog
whereas the time span of the raw data display is determined by the
chosen sampling rate and the number of channels selected for
acquisition, and it can not be changed. However, the time marks
can be set to appear at user specified intervals by the Scales...
dialog. The default scales can be configured by qualified service
personnel.

Amplitude scales
MEG scale (T) ol
EEG scale (uY)  HEa]
EOG scale (ut)  HEalf]
EMG scale (uY)  HEaH]
ECG scale (uV)  Falln
Stim scale (V) R

11000000.0

Py
1 Apply notch filters for EEG

¥ Apply notch filters for

Line frequency

Apply . | Help
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Magnetometer and axial gradiometer channels typically require
wider display scales than planar gradiometer channels. The axial
sensor scale multiplier (Axial Mult) multiplies the MEG scale fig-
ure to set the vertical scale for axial gradiometer and magnetom-
eter channels.

By default, raw data display subtracts the average signal ampli-
tude calculated over the display time span from each sample thus
keeping the signal traces on the display even when strong low fre-
quency signal components are present. This behavior can be
switched on and off by toggling Remove DC offset button. This
affects only the display and not the raw data recorded to a file.

If an on-line signal space projection operator (see Section 3.10) is
used, the projection for the display can be controlled by the Apply
SSP button. Note that this doesn’t have any effect on the raw data
recording.

Use of low-pass filtering can be controlled by the Apply low-
pass filter buttons. The low-pass corner frequency can also be
entered.

Use of notch filtering can be controlled by the Apply notch filter
buttons. If turned on, the specified line frequency and its first two
harmonics (e.g. 50 Hz, 100 Hz, and 150 Hz) are filtered out.

5.3.4. XY display

The tuning of the SQUID sensors can be done without an analog
oscilloscope by using the XY display incorporated in the raw data
display. The XY display shows the signal from one channel at a
time; the Y (vertical) deflection is driven by the output of the
selected channel whereas the X (horizontal) deflection is driven
by the excitation signal fed to the SQUIDs in the tune mode.

Oscilloscope

=50

< [25 5.0][10.0 MEG1423

Hide
pEd
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The XY display works in conjunction with the Squiddler pro-
gram so that selecting a channel in Squiddler automatically
selects the same channel for the XY display. In addition, the
arrow buttons can be used to select any individual channel. You
can also choose from three different scales.

Tuning is described in more detail in “Sensor Tuner User’s
Guide”.

5.4. On-line averaging

5.4.1. Messages

As mentioned in Section 5.1, on-line averaging is switched on and
off from the Average control button. The number of responses
averaged into each category is listed on the third message line. If
an epoch is rejected from the average, a message indicating this is
displayed on the fourth message line. The Epoch rejected mes-
sage will remain for a while even if subsequent epochs are again
accepted. Reasons for the rejections are listed in the log message
area at the top of the main control window.

5.4.2. Adjusting on-line averaging

You will notice that the on-line averaging setup button remains
active even during acquisition. Therefore, you can change the on-
line averaging parameters during acquisition. If you accept the
changes, all existing averages are cleared and the averaging is
started from beginning. Changes to the on-line averaging param-
eters do not affect the raw data collection.

5.4.3. Marking channels as “bad”

You can set channels to be ignored from the on-line artefact rejec-
tion procedure from the dialog that appears when you select Set
bad channels... from On-line menu. If some channels are caus-
ing rejections and you would like to continue without rectifying
the problem, check the corresponding channels in the bad chan-
nels dialog. The ignored channels will be marked ‘bad’ in the
resulting evoked-response output files but their signals will nev-
ertheless be present in both average and raw data files unlike
those channels that are turned off.

5.4.4. On-line average display

During averaging, partial results are displayed at selectable inter-
vals in the standard plotting program, xplotter, as discussed in
Section 3.5.7. You can manipulate the display of responses (filter-
ing, baselines, scales, etc.) in the xplotter window during acquisi-
tion.
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If you would like to update the averages without waiting for the
selected time interval to elapse, select Update average display
from the On-line menu. When you schedule a display update
manually, the display update timer will be reset and the next
update will be scheduled to occur after the regular interval from
the manual display update.

5.4.5. Select displayed categories

The categories displayed on-line are initially selected from the
averaging parameters dialog. You modify the selection of dis-
played categories and on-line display update rate from Select
displayed categories... in the On-line menu. The choices are
kept between acquisitions, i.e., any changes made here are equiv-
alent to modifying the standard averaging parameter dialog with
the exception that the on-line averaging is not restarted from the
beginning when you activate the changes from the OK button.

When on-line averaging completes, all categories averaged are
always displayed, regardless of the currently active display selec-
tion.

If on-line averaging is not active, selecting displayed categories
gives an error message.

5.5. Raw data recording

While the measurement is running you can start recording raw
data by using the Record raw button in the acquisition controls.
If you switch recording on and off several times during one mea-
surement, the separate segments of raw data will be concatenated
into the same raw data file. Since all the segments will have time
tags referring to the actual measurement time, the different seg-
ments can be identified at the analysis phase.

When raw data is being recorded, the amount of data recorded as
well as the amount of free disk space are displayed on the second
message line of megacq.
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5.6. EEG impedance measurements

The acquisition system allows easy measurement of EEG elec-
trode impedances. When EEG channels have been activated, the
EEG impedance display pops up automatically when a measure-
ment is started.

4 EEG Impedance Check

EEG 001 I NF
EEG 002 [ NF
EEG 003 D NF
EEG 004 D NF
EEG 005 | NF
EEG 006 [ NF
EEG 007 | NF
EEG 008 I NF
EEG 009 I NF
EEG 010 [ NF
EEG 011 [ NF
EEG 012 [ NF
EEG 013 D NF
EEG 014 I NF
EEG 015 [ NF
EEG 016 [ NF
EEG 017 [ NF
EEG 018 I NF
EEG 019 I NF
EEG 020 [ NF
EEG 021 [ NF
EEG 022 I NF

The impedances are measured by checking the small check-box at
the left upper corner of the dialog. When the impedance measure-
ment is started EEG system starts feeding probe currents to the
electrodes and measures the resulting voltages. The amplitudes of
the voltages are shown as impedance values on the dialog.

The display has color coding indicating high resistance (red),
intermediate resistance (yellow). and low resistance (green). By
default, low resistance is below 5 kOhm for normal EEG channels
and below 75 kOhm for the bipolar ones. High resistance is over
20 kOhm for normal EEG channels and over 100 kOhm for bipo-
lar ones.

Note: Currents are fed to the electrodes during the impedance
measurement. This prevents making normal EEG measurements
while the impedance measurement is on.
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5.7. Stopping the acquisition

When you have collected the desired number of responses into the
averages and you have collected all necessary raw data, press
Stop to finish the acquisition. If on-line evoked-response averag-
ing was requested, the save dialog for evoked-response data will
appear automatically once all data have been processed. After the
evoked-response data are stored, a dialog prompting for the raw
data file name will appear if any raw data were collected.

If you choose not to save either data, the system will emit a “last
chance” message when starting a new measurement which would
destroy these data.

See Section 6.2. “Saving averages and raw data” on page 50 for
details about saving your data.
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6. SAVING DATA

6.1. Data volumes

Acquired data are saved to one of the predefined data volumes.
Under the volume top level directory, the data files will be stored
n

<project>/<last name>_ <first name>/<date>,

if you are studying a volunteer, or
<project>/case_<id>/<date>

if your subject is a patient, as explained in Section 3.2.2.

If no subject name has been selected, the subject part of the path
will be no_name.

If the volume is a removable one (magneto-optical disk, MOD)
you must first mount the volume to make it usable. Before the
MOD can be removed from the drive, it must be released or
unmounted. Mounting and unmounting as well as other data vol-
ume management procedures are described in Section 7.2. on
page 52.

6.2. Saving averages and raw data

If any on-line averages were computed or raw data was recorded,
a saving dialog appears automatically. The user is first prompted
for saving averages, if any. In this case the dialog is titled Save
evoked responses. The user is then prompted for saving raw
data, if any. In this case the dialog is (re)titled Save raw data.

Saving is done in background. Therefore, you can continue with
the next acquisition while saving of previously acquired raw data
is still in progress. You can iconify the Raw data saving window.

If the recorded raw data file size becomes larger than a predefined
value (in normal configuration 2GB minus 100MB), the data file
is closed and a new continuation file is created. The exact size of
the file can vary somewhat depending on how the internal blocks
exceed the limit. When this kind of a split measurement is saved,
the first segment is given the name which user writes into the sav-
ing dialog. Rest of the segments have the same name with a dash
and a running number appended (numbering starts from one).
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6.3. The saving dialog

=
Volume : Default — | /neuro/data 5686.10 Mbytes free 2,

Dest. directory: fneuro/datatestino_name/061211

File name ;
.

Caomment EE\A’ectoruiew system at Meuromag LM3SR

User : Elekta Meuromag (neuromag)

S el el

Saveridle,

Save Sl Discard Help
| | |

8. 9. 10.

The saving dialog has the following components:
1. An option menu to select the destination volume.

2. The root pathname of the selected volume and the amount of
free space on the volume.

3. The destination directory for the data.

4. Atextfield to enter the destination file name. Use only letters,
numbers and the underscore character in the file name. The
suffix .fif is appended automatically.

5. A text field to enter a comment to go with the data.

Real and login name of the current user, which are saved with
the data.

7. Status line indicating the state of saving.
8. Save button to start saving.
9. Stop button to interrupt saving.

10. Discard button to discard the averages or raw data.

6.4. Rescuing data after a crash

If you have collected evoked-response or raw data and megacq
ceased to work after you pressed Stop, you can rescue your data
by double-clicking the RescueEvokedData or RescueRawData
icon in the Maintenance folder.

If there is some data to be saved, you will first see a dialog to con-
firm that you would really like to proceed. Thereafter, a standard
megacq saving dialog (see Section 7.3) will appear. Note that the
rescued data will be saved under the project directory called
unknown if the real project name could not be retrieved.
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7. MANAGING DATA VOLUMES

7.1. Concepts

A data volume is a collection of data under some directory in the
hierarchical file directory structure. We call this directory the vol-
ume root.

The data are located under the volume root under directories
<project name> / <subject name> / <date>

for example,
test/phantom_phyllis/940530

A volume may reside either on a hard disk or on a magneto-opti-
cal disk (MOD). A MOD volume is also called a removable vol-
ume.

A removable volume must be mounted before it can be accessed.
Mounting refers to joining the file system on a disk as an integral
part of the directory hierarchy. Before a MOD can be physically
removed, the disk must be removed or unmounted from the direc-
tory hierarchy. A disk can be unmounted only after all open files
on that disk have been closed. In addition no process should have
its working directory set to a directory on that disk.

Before you can start using a MOD you must initialize (“format”)
the disk, i.e., create the file system structures on the disk. This
task is described under Section 7.2.5. on page 55.

7.2. Accessing data

7.2.1. Basics

All data volumes are accessible from the Data directory under the
Neuromag toolbox in CDE:

When you double click the Data directory icon, a volume manip-
ulation window appears. The exact contents of the window
depends on what data volumes have been configured into the sys-
tem. E.g. the MOD related icons are present only if a MOD vol-
ume is configured.
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This window contains:

1.

N kA v

An icon for each available data volume. The icons are labeled
Volume:<volume name>.

A volume is an association between a symbolic volume name
and a point in the file directory structure, volume top level
directory.

MOD mounting icon (MountVolume)
MOD unmounting icon (UnmountVolume)
MOD initialization icon (InitVolume)
Volume listing icon (CatalogVolume)
Volume backup icon (BackupData)

Data restore icon (RestoreData)
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7.2.2. Displaying a volume

To display the contents of a volume, double click the icon of the
desired volume. If this is a volume residing on a hard disk, the
contents of the top level directory is displayed. If the volume is a
removable one, the system first checks that the volume is
mounted. If not, you are asked to mount the volume first (see Sec-
tion 7.2.3. on page 54).

The contents of the data volumes are displayed in standard CDE
File manager windows. To learn about the CDE File manager,
please study the printed or on-line CDE documentation.

7.2.3. Mounting and unmounting

To mount a removable volume, proceed as follows:

1. Insert the disk into the magneto-optical disk drive. The drives
are usually labelled with the volume names.

2. Drag the volume icon corresponding to the MOD on top of
the MountVolume icon

or

Double click the MountVolume icon and enter the volume
name to the dialog that appears.

The MountVolume action first asks you to press return after the
MOD is inserted. Thereafter, it creates the mount point directory
(/mod) in the workstation where the MOD drive is located.
Finally, the MOD is 'exported' to the workstation you are using
and made accessible there. This arrangement allows you to access
the MOD from the system you are directly connected to.

To unmount a removable volume,

Drag the volume icon corresponding to the MOD on top of
the UnmountVolume icon

or
Double click the UnmountVolume icon and enter the volume
name to the dialog that appears.

Sometimes it is not possible to unmount a volume. This is most
probably due to programs having files open or working directory
set to the volume you are trying to unmount. UnmountVolume
automatically checks these processes and provides you a list.
After you have quit the programs you can try unmount again.

7.2.4. Copying data

To copy files from volume A to volume B:

1. Open volume A by double clicking its icon.
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2. Go to the directory containing the source files within volume
A.

3. Drag the files to be copied onto the icon of volume B.
The copying operation creates the directory tree for the destina-

tion files automatically. At present, you cannot copy entire direc-
tory trees. If one of the files you drag is a directory, it is skipped.

Note: If you drag an icon from a window displaying data from a
volume to a window displaying in another volume, the file is
moved instead of being copied. You can copy a file by holding the
control key down before you start moving the icon.

7.2.5. Initializing MOD's

To initialize or reinitialize a MOD perform the following steps.
Note that the re-initialization irreversibly destroys all information
on the disk.

1. Insert the disk into the magneto-optical disk drive. The drives
are labelled with the volume names.

2. Drag the volume icon corresponding to the MOD on top of
the InitVolume icon

or

Double click the InitVolume icon and enter the volume name
to the dialog that appears.

It is recommended that you initialize both sides of a MOD under
the same session. If the MOD you inserted is already initialized
you are asked whether you want to reinitialize it. Just before start-
ing the initialization InitVolume asks for a final confirmation.

Note: Due to a bug in HP-UX the system may crash if you at-
tempt to mount a MOD during initialization.

7.3. Listing the contents of a volume

The CatalogVolume icon provides access to a script to compile
a full or a partial table of contents of a volume either to a terminal
window or to a printer.

To produce the listing, drag the volume icon corresponding to the
volumeMOD on top of the CatalogVolume icon.

You will be asked a series of questions regarding the type of list-
ing you want to produce.
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7.4. Backing up a volume

Backing up refers to copying all or selected files of a volume onto
a DAT tape. Before starting the backup, insert a write-enabled
empty tape into the DAT drive. The current setup does not allow
appends to the tape. Therefore, be careful to label your tapes so
that valuable data are not accidentally overwritten.

If you are backing up an MOD, insert it into the drive (side A first
if the whole disk is to be backed up) but do NOT mount the MOD.

The backup operation is started by dragging and dropping the cor-
responding volume icon on the BackupVolume icon. After that
you can choose to backup the whole volume or to restrict the oper-
ation to specific subdirectories, which is useful e.g. for backing up
only some of the projects on the selected volume. You will pro-
vided with a list of the directories in the root directory of the
selected volume to make it easy to choose the projects to back up.

Finally, you will have the option to automatically verify the DAT
tape after the backup. The verification procedure rewinds the
tape, reads it, and prints a listing of all files and directories found
on the tape. Note that this takes almost as long as the actual
backup.

If you chose to backup a whole MOD, side A is first backed up,
and then you will be asked to turn the MOD. The files on side B
will be appended onto the tape after the files from side A, so do
NOT eject and re-insert the tape at this point or you will overwrite
the backup of side A.

Note that all the backup operations will leave the original files
untouched.

7.5. Restoring data

This is the reverse operation of backing up, i.e. files stored on a
DAT tape are copied to an MOD or hard disk volume. Before try-
ing a restore, check that you have enough free space on the desti-
nation volume.

Insert the DAT tape into the drive and drag-n-drop the destination
volume icon on the RestoreVolume icon. Follow the instructions
on the screen.
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8. RESTARTING THE SOFTWARE

The data acquisition may under some circumstances either stop
prematurely or freeze with the following symptoms:

1.

2.

Megacq becomes nonresponsive for a long time. When win-
dows covering megacq are moved, the exposed areas are not
repainted.

When megacq is started it fails to contact the data server.

Most common reasons for this are overloaded acquisition work-
station and networking problems. You can recover the system by
restarting the acquisition software modules:

1.

Double click the Maintenance icon in Neuromag toolbox to
open the folder of maintenance actions.

Double click the RestartAcqPrograms icon.

Confirm that you really want to proceed by answering y to the
question appearing in the RestartAcqPrograms terminal
window.

Wait until the question

Do you want to reboot or just restart
servers (b/s):

appears and type ‘b’ or ‘s’ followed by <Enter>.
Wait until the message

Restart complete. Press <Enter> to close
the window

appears and press <Enter>.

If you have collected evoked-response or raw data and meg-
acq ceased to work after you pressed Stop, you can rescue
your data by double-clicking the RescueEvokedData or
RescueRawData icon in the Maintenance folder.

If there is some data to be saved, you will first see a dialog to
confirm that you would really like to proceed. Thereafter, a
standard megacq saving dialog (see Section 7.3) will appear.
Note that the rescued data will be saved under the project
directory called unknown if the real project name could not
be retrieved.

Restart megacq by double clicking the Acquisition icon in
the Neuromag toolbox.

If you have completed the HPI digitization, you will be given
a chance to use the HPI data again. Alternatively, you can use
Load preparation in the file File menu which allows quick
restoration of the previous setup of the acquisition software.

Reload the SQUID tuning file if the power-up tuning settings
are not optimal. Restore the EEG amplifier settings if not
using the defaults.
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APPENDIX A

Software Structure

The acquisition software consists of several software modules
running on the acquisition workstation and on the real-time com-
puter of the data acquisition unit. The workstation and the data
acquisition unit are interconnected through a dedicated local area
network.

The user interface of the acquisition system is completely on the
workstation while the data acquisition unit does not require any
direct user interaction. The software is based on client-server
architecture: programs providing user interfaces are clients of the
servers performing the corresponding actual tasks as instructed
by the clients. Most of the servers are running on the data acqui-
sition unit whereas the clients are running mainly on the acquisi-
tion workstation. Clients and servers communicate by using
network connections.

The components of the data acquisition software are listed below.
The corresponding UNIX process names are indicated in paren-
thesis. Note that users don’t have to start all of these modules
explicitly; most of them are automatically managed by the data
acquisition control module and others are continuously running as
background processes.

1. The magnetometer electronics control server (janitor), EEG
control server (janitor_eeg), and the data collector server
(collector) on the real-time computer.

2. Data server module (dacq_server_peer) which receives data
from the real-time system and provides it to client processes
on the acquisition workstation.

3. Data acquisition control module (megacgq).
Raw data display (rawdisp).

5. Real-time averaging (averager) and on-line average display
(xplotter) modules.

6. Head digitization server in the UNIX workstation (isotrak)
which communicates with the Isotrak 3D digitizer.

7. Head-position indicator data handling (Api) and position fit-
ting (hpifit) modules.

8. Magnetometer tuning (Squiddler), and quality-assurance
software (noise_meas) in the acquisition workstation.

9. EEG control program (Squiddler_eeg).

10. Liquid Helium level monitoring module (heliumd) and
Helium level history viewer and zero level estimation module
(helium).

11. Acquisition troubleshooting and maintenance utilities.
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APPENDIX B Changes from previous release

New features in Release 4.0:

MaxShield active compensation system support.
Continuous head position indicator support.
Support for 32 bit data in acquisition software.

Reorganized start and restart buttons to prevent accidentally
pressing ‘restart’ button instead of ‘stop’ button.

Estimation of HPI signal amplitude now filters out line fre-
quencies.

Gantry position setting integrated into acquisition control
interface.
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